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Windographer Version History - Summarized 
 
Windographer 5.3.10 (January 17, 2025) 

• Fixed small user interface bugs. 

• Improved layout and image quality of graphs in reports. 

• Improved import logic to recognize latitude and longitude in Windcube files. 
 
Windographer 5.3.9 (December 28, 2024) 

• Fixed bug causing Data Downloader window not to work on some computers. 

• Added option to open a report in Word as soon as it is generated. 
 
Windographer 5.3.8 (December 20, 2024) 

• Improved Data Downloader window. 

• Added option to control handling of time zones during append process. 

• Added concurrency-within-datasets filter to Long Term Patterns window. 

• Added support for system proxy automatic setting detection (WPAD). 

• Added ability to export MGM files. 

• Improved time series graph's response to arrow keys and mouse wheel. 

• Added the ability to include vertical extrapolation in a workflow. 

• Added the ability to include report generation in a workflow. 

• Improved appearance of formatted reports by reducing image scale. 
 
Windographer 5.3.7 (November 15, 2024) 

• Fixed bug preventing the computer-level licensing process from working. 

• Add ability to import MGM files. 

• Made Long Term Patterns window more responsive by using background processing. 
 
Windographer 5.3.6 (October 18, 2024) 

• Restored option to initialize Flag Manually window from Time Series window. 

• Fixed bug in calculation of data coverage rate. 

• Added support for system proxy and PAC files. 
 
Windographer 5.3.5 (September 23, 2024) 

• Made Data Downloader window no longer require a Windnavigator account. 

• Added username and password to proxy settings. 

• Fixed bug causing Ratios window to show no data when filtering by a data column. 
 
Windographer 5.3.4 (August 29, 2024) 

• Fixed bug causing license activation to fail in some cases. 

• Added ability to expand and contract sections of the time series graph legend. 
 
Windographer 5.3.3 (August 27, 2024) 

• Allowed workflows to reconstruct datasets. 

• Allowed workflows to execute flag rules. 

• Allowed workflows to set properties of multiple datasets at once. 

• Stopped LTA window speed vs. direction mode from ignoring concurrency requirement. 
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• Stopped Flag Manually window from resetting selected flags after applying a flag. 
 
Windographer 5.3.2 (June 11, 2024) 

• Added the Workflows window. (Enterprise only) 

• Added the Advisor window. (Enterprise only) 

• Added option to define a calculated column with an equation. 

• Added option to add turbine power output to dataset as a calculated column. 

• Added the Ratios window. 

• Added second pathway to Long Term Adjustment window. (Enterprise only) 

• Added Shear Model window. (Enterprise only) 

• Added the Synthesize Wind Speed Data tool window. 

• Changed to new license system. 

• Added option to specify testing/training period for MCP algorithm performance test. 
 
Windographer 5.2.17 (August 28, 2024) 

• Made dataset nickname appear in first line of TAB files. 

• Stopped resetting selected flags after flag application in Flag Manually window. 

• Fixed bugs with scatterplot 'color by flag' mode. 
 
Windographer 5.2.16 (July 3, 2024) 

• Improved database export logic to handle rare circumstances. 

• Improved WIS file logic to accept a specified time step without a specified start date. 
 
Windographer 5.2.15 (May 27, 2024) 

• Fixed bug causing incorrect dates to appear in scatter plot tooltips in some cases. 

• Fixed occasional incorrect dates in Data Coverage window ‘missing data’ table. 
 
Windographer 5.2.14 (May 6, 2024) 

• Fixed bug that blocked the initiation of a trial license. 

• Fixed bug that prevented reconstruction of some data points in some circumstances. 

• Added option to export to XML the list of imported/appended datasets. 
 
Windographer 5.2.13 (April 30, 2024) 

• Fixed bug preventing import of windog v4 files with broken calculated columns. 

• Added option for sector-varying displacement height to depend on the primary vane. 

• Made template application process more forgiving. 

• Improved Ammonit file import to recognize new wind vane offset. 

• Improved Oracle database import and export. 

• Improved database export logging. 

• Fixed bug causing Correlation window not to react to filter changes. 

• Fixed bug causing Workbook Explorer not to refresh after reconstructing single dataset. 
 
Windographer 5.2.12 (March 5, 2024) 

• Fixed bug (introduced in v5.2.9) that caused incorrect statistics-by-sector results. 

• Small improvements to reading and writing IEA Task43 JSON files. 

• Improved data file import logic. 
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Windographer 5.2.11 (February 13, 2024) 

• Fixed bug preventing floating licenses from working correctly. 

• Fixed bug causing the ‘overlap period’ filter to work incorrectly. 

• Improved detection of latitude, longitude, and elevation when importing data files. 

• Added single-dataset ‘reference periods’ option to Long Term Patterns window. 
 
Windographer 5.2.10 (January 17, 2024) 

• Fixed bug that caused some license activations to fail in v5.2.9 without cause. 
 
Windographer 5.2.9 (December 29, 2023) 

• Fixed bug that could cause the append process to skip files even after user resolves conflicts. 

• Fixed bug preventing a TI column from updating after change to its speed column. 

• Added a correlation-vs-distance display mode to the Correlation Analysis window. 

• Fixed bug causing spurious conflicts when appending datasets with measured TI columns. 
 
Windographer 5.2.8 (October 30, 2023) 

• Fixed bug preventing import of certain Ammonit Meteo-40 data files. 

• Fixed bug preventing display of time series graphs in the Extreme Winds window. 
 
Windographer 5.2.7 (October 23, 2023) 

• Fixed bugs in MySQL database communication. 

• Added buttons to LTA window to export and import settings. 

• Added button to calculate backup displacement height as weighted average of sectoral values. 

• Improved speed of MCP algorithm test process. 

• Improved text and Excel file import logic. 

• Fixed bug in concurrency logic in Wind Speed Sensor Summary and multi-dataset diurnal profile. 

• Fixed bug in concurrency logic in multi-dataset turbulence calculations. 

• Fixed bug in DCR calculations in monthly and daily stats tables when combining years. 

• Fixed bugs causing WindSim export files to react incorrectly to a user-specified date range. 
 
Version 5.2.6 (September 27, 2023) 

• Allowed Flag With Rules window to execute rules on multiple datasets at once. 

• Fixed bug in MCP logic causing incorrect below-speed-cutoff correlation. 

• Fixed bug in database import/export of document history notes. 

• Improved reporting of curtailed output in the Wind Turbine Output window. 

• Adjusted EPE export format slightly. 
 
Version 5.2.5 (August 24, 2023) 

• Allowed drag-and-drop reordering of datasets in Workbook Explorer. 

• Made all datasets in the workbook share the same flags and rules. 

• Fixed bug preventing import of multiple encrypted RWD files. 

• Fixed bug causing occasional crash when importing Kintech WND files. 

• Fixed bug in the calculation of error codes in the EPE export format. 

• Improved template application process, especially IEA Task43 JSON files. 
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Version 5.2.4 (July 22, 2023) 

• Improved reporting of observed peak wind speed in Extreme Wind window. 

• Fixed bug where LTA window's reference comparison table displayed incorrect regression data for 
direction and temperature. 

• Fixed bug in which moving a dataset down caused a duplicate instead. 

• Made Vertical Extrapolation window respond correctly to a change in sectors. 

• Fixed bug affecting calibration timing when prepending a windog file. 

• Improved import/export of IEA Task 43 JSON files. 
 
Version 5.2.3 (July 13, 2023) 

• Added a toolbar button to duplicate datasets. 

• Added multi-dataset mode to Delete Data window. 

• Added ability to drag-and-drop a Task43 JSON file onto a workbook. 

• Improved Export Data window to allow export of multiple files before closing window. 

• Made Openwind multi-height export accept direction and temperature sensors at other heights. 

• Improved robustness of database import and export processes. 

• Cosmetic improvements to Word-format reports. 

• Small improvements to raw data file import logic. 

• Adjusted number formatting in EPE export file. 

• Added the Gumbel fit algorithm option for the MIS extreme wind method. 

• Added concurrency restriction to multi-dataset mode of Long Term Patterns window. 

• Added correlation-by-sector option to the Correlation analysis window. 

• Added the Test Uncertainty button to the Reconstruct Across Datasets window. 

• Added WRA Datasets Summary table, and the beginnings of the UL EPR report. 

• Refined zoom and scroll resolution of time series graphs. 

• Fixed bug causing LTA window to display incorrect onsite or reference dataset statistics sometimes. 

• Added 'reference periods' display mode to Long Term Patterns window. 

• Added 'long term trends' display mode to Long Term Patterns window. 
 
Version 5.2.2 (May 18, 2023) 

• Fixed bugs in EPE export format. 

• Fixed bug in reconstruction logic that produced negative speeds in rare cases. 

• Fixed bug that could cause resample process to crash in rare circumstances. 

• Fixed bug that could cause TAB file export logic to crash in rare circumstances. 

• Fixed recent bug that sometimes prevented time series graph from zooming in or out. 

• Made View > Reports visible to everyone, not just UL users. 
 
Version 5.2.1 (April 21, 2023) 

• Fixed bugs in text file import logic. 

• Fixed bug stopping the extrapolation process under certain circumstances. 

• Modified EPE export format slightly. 

• Refined zooming and scrolling behavior of time series graphs. 
 
Version 5.2 (April 3, 2023) 

• Added Correlation analysis window. 

• Added Data Destination window, which appears when you drag and drop files. 
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• Added option to export dataset locations to KML. 

• Added export and import of IEA Task 43 JSON files. 

• Added speed, direction, and temperature column inputs to the LTA window. 

• Added a 'by bin' option to the Apply Scale and Offset window. 

• Allowed the scale and offset process to apply only to specifically flagged data points. 

• Added the shear-by-layer mode to the Shear Analysis window. 

• Allowed vertical extrapolation of TI data even for datasets containing measured TI data. 

• Added Notes tab to History window. 

• Added reports module that creates reports in Word format. 

• Allowed filtering by time of day and by month range. 

• Improved history window descriptions of several kinds of revisions. 

• Added Tools > Options control of power law exponent decimals. 
 
Version 5.1 (Mar 25, 2022) 

• Added user control over the size of the undo buffer to limit windog file size. 

• Added buttons to Dataset History window to allow user to trim revisions to shrink file size. 

• Improved performance of Configure Dataset and Long Term Adjustments windows. 

• Added Save Template and Load Template buttons to Configure Dataset window. 

• Added workbook summary graphs to the main window. 

• Allowed wildcard flag rules to refer to all types of data columns. 

• Added user control over which column types display by default in time series graphs.  

• Expanded WIS files to encompass data column properties and displacement height. 

• Added MCP algorithm performance test window. 

• Added Test MCP Uncertainty window that measures uncertainty using a bootstrap analysis. 

• Added a 'correct tower shading' mode to the Correct Tower Distortion window. 

• Added option to filter by maintenance periods in Scatterplot, In Situ, and Tower Distortion windows. 

• Added high wind hysteresis modeling to Wind Turbine Output window. 

• Added temperature shutdown and derating to Wind Turbine Output window. 

• Improved data import logic. 

• Fixed bugs in append process, reconstruction process, and EPE export. 

• Fixed bugs in Flag By Scatter Plot, Long Term Adjustments, and In Situ Comparison windows. 
 
Version 5.0 (Aug 17, 2021) 

• Added ability for a workbook to contain multiple datasets. 

• Allowed display of multiple analysis windows at a time. 

• Added option to undo changes to datasets. 

• Allowed import of data with timesteps smaller than one second. 

• Changed to 64-bit programming to handle more data. 

• Added module for in situ comparison of anemometers. 

• Improved file import logic. 
 
Version 4.2.25 (May 9, 2024) 

• Improved import logic to handle latest Kintech WND file format. 
 
Version 4.2.24 (May 8, 2024) 

• Changed license activation/deactivation process to use HTTPS protocol rather than HTTP. 
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Version 4.2.23 (Feb 2, 2023) 

• Fixed bug preventing multi-height export to Openwind. 
 
Version 4.2.22 (Jan 5, 2023) 

• Improved Kintech import logic to handle new EOL Zenith format. 

• Fixed bug causing incorrect scaling of Weibull fit on Histogram tab. (This bug doesn't exist in v5.) 

• Added new monthly met tower report. (for UL French office) 

• Fixed bug where old MCP window's diurnal profile graph sometimes incorporated invalid data. 

• Adding mean-of-distribution to Openwind export tab to help comparison to Openwind. 
 
Version 4.2.21 (Mar 22, 2021) 

• Improved scatter plot legend to show regression line equation. 

• Moved main window scatterplot legend to inside top left corner. 

• Updated EPE export tab to reflect latest guidance from the Brazilian EPE. 

• Added new module to calculate gap fill uncertainty with k-fold cross validation. (Formerly Enercon only) 
 
Version 4.2.20 (Dec 21, 2020) 

• Added measurement heights and DRR to WindographerMCP Onsite Data summary table. 

• Added 'frequency & energy by sector' display to WindographerMCP Onsite Data tab. 

• Added option to include flag status in time series export files. 
 
Version 4.2 (May 31, 2019) 

• New option to set the time zone in the Configure Data Set window. 

• New option to make displacement height vary by direction sector or month. 

• Improvements to WindographerMCP 
o New display options on Onsite Data and Long-Term Data tabs. 
o New ability to select subset of data sets for analysis. 
o New ability to define any number of long-term adjustments. 
o New concurrency and filter options. 
o New ability to detect and correct time offsets between data sets. 
o New logic to determine minimum number of data points for regressions. 
o New long-term scaling options including scaling each month separately. 
o Improved control, reporting, and documentation of reconstruction process. 

• Improvements to Vertical Extrapolation window 
o Option to restrict the shear parameter range to mean plus/minus X standard deviations. 
o Option to rescale to a desired mean value after extrapolation. 

• New option to use Larsen & Hansen ‘detrending’ process on TI columns. 

• New Correct Tower Distortion module. 

• New data column types for solar irradiance and battery voltage. 

• New option to specify multiple RH data columns at different measurement heights. 

• New option to import and export turbine properties in WTG and OWTG formats. 

• Added Shear tab to Tools > Options window, and made shear evaluation method and shear lookup table 
type an option the user can set in Tools > Options for speed, speedSD, direction, and temperature 
extrapolation. 

• Improved import and export logic. 
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Version 4.1 (January 19, 2018) 

• Added new MCP module capable of handling multiple onsite and reference data sets. (Full capability 
available to subscription licensees only.) 

• Added handling of boom orientation 
a. Added boom orientation to Calibration window. 
b. Added combine-by-boom-orientation to Combine Anemometers window. 
c. Added by-boom-orientation mode to Flag Tower Shading window. 
d. Added logic to read boom orientation from RLD and NDF files. 

• Added displacement height to the Configure Data Set window. 

• Improvements to Configure Data Set window: 
a. Faster processing 
b. New Copy Data Column(s) button 
c. New Convert to Static Column(s) button 
d. New ability to specify measured TI columns 
e. Now displays version number of the copy of Windographer that wrote the file 

• Improved Vertical Extrapolation window: 
a. New more flexible and more realistic method of extrapolating speed SD data. 
b. Now allows extrapolation from a specific sensor or the line of best fit 
c. Now allows user to specify the type of lookup table to be used for backup when in by-time-step 

mode 
d. Now shows a preview of synthesized data columns 
e. Added option to compare extrapolated time series with column in another (or same) data set. 
f. Improved extrapolation of speed SD data to mimic measured shear patterns much more closely. 

• Added save button to Flag Manually window 

• Improvements to Document History window: 
a. Complete reporting of vertical extrapolation, gap filling, and scaling processes 
b. Added Reviewers tab 

• Improvements to Tower Distortion Analysis window 
a. Window is now modeless, meaning one can leave it open while using other windows 
b. New option to subdivide by year or month 
c. Graphs now indicate boom orientation 

• Improved Data Recovery Analysis window 
a. New option to display data coverage chart of valid or invalid data 
b. New table showing missing data 
c. New option to report valid time steps rather than data recovery rate 

• Added 'Openwind' Weibull fit algorithm. 

• Added the ability to choose a Weibull fit algorithm in Tools > Options. 

• Improvements to Combine Anemometers window: 
a. Now creates combined max column as well as combined SD column 
b. New option to combine by boom orientation  
c. New option to use reconstruct-and-average when combining 

• Added to Fill Gaps window the option to replace data flagged to exclude. 

• Improved gap fill process to reconstruct co-located speed sensors first, using regression-by-sector, 
before doing shear-based reconstruction. 

• Improved Wind Shear Analysis window 
a. Added speed SD shear. 
b. Added option to calculate from MoMM or simple mean. 
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• Improved Compare Data Sets window 
a. Added option to display sensor nearest X metres in height 
b. Added speed frequency graph 
c. Added TI-vs-height and TI-vs-speed graphs 

• Added Special Adjustments window to perform NRG TI adjustment. 

• Improvements to the Tables tab: 
a. New ‘Data Channel Summary’ table 
b. New ‘Quarterly Statistics’ table 
c. New ‘Daily Statistics’ table 
d. New ‘Calibration History’ table 
e. New ‘Combined Wind Speed Sensor’ table 
f. New ‘Statistics by day of year and hour of day’ table 
g. New ‘Statistics by hour of year’ table 
h. Added MoMM to Data Columns table 
i. Added MoMM and energy-weighted density to Environmental Summary table. 

• Improvements to calculated column capability: 
a. New calculated column type for speed SD shear parameter. 
b. New calculated column type ‘Dew point’ 
c. New calculated column type ‘Inflow angle’ 
d. New calculated column type ‘First difference’ 
e. New calculated column type ‘Density-adjusted wind speed’ 
f. New calculated column type ‘Energy-weighted air density’ 
g. New option to auto-create a ratio column for co-located speed sensor pairs 
h. New option to control whether to use the ISA to synthesize temperature or pressure data for air 

density calculated column 

• Improvements to data import process: 
a. Added separate control of append overwrite settings for numeric data and flag status 
b. Improved data column identification (and association) logic 
c. Improved import of ASOS files, MM files 
d. Windog file now stores folder from which the user most recently imported data. The File > 

Append process now takes you to that folder by default when appending again. 

• Improvements to Export Data window: 
a. Made window resizable and maximizable 
b. Added gust factor to Openwind export format 
c. Slight improvement to MM file export, to report air density as -999 with the others when 

necessary. 
d. Added ability to specify temperature sensor when exporting single-level MM file. 
e. Added option to use AWST air density assumptions in Openwind export file. 

• Improvements to Wind Turbine Output window: 
a. New option to display results in 8760 and 365x24 tables 
b. New option to disable air density adjustment 

• Improved Representative Year window to encompass multiple data columns. 

• Added 'frequency & energy' display option to the Wind Rose tab. 

• Improved Apply Scale and Offset window to allow scaling by month, hour of day, or sector. 

• Added trend and discontinuity testing to Long Term Analysis window. 

• Improved MTS algorithm 
a. Added option to subdivide by year divisions. 
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b. Added option to window bins on joint probability distribution. 

• Introduced database interface revision 6. 

• Added ability to open RLD files from the SymphoniePRO data logger. 

• Improved RWD file import process, added option to ignore site files. 

• Improved NSD import process to read calibration constants and serial numbers 

• Switched to Yamartino method for calculating standard deviation of directional data. 
 
Version 4.0 (May 18, 2015) 

• New Calibration window. 

• Expanded calculated column capability with many new options. 

• Ability to import much larger text files. 

• New ability to hide data columns from graphs and drop-down boxes. 

• Document History window now displays a complete list of configuration changes. 

• New Combine Anemometers window for combining co-located anemometers. 

• Easier sharing of favorite flags and flag rules within a team. 

• New ability to scale (rather than lengthen) the target data set in MCP module. 

• MCP performance test now compares different settings as well as different algorithms. 

• MCP performance test now allows multiple iterations to help determine uncertainty. 

• Vertical Extrapolation window now includes turbulence, directions, and temperatures. 

• New ability to export multiple-height data to Openwind in the form of an MM2 file. 

• Gap fill process now offers option of shear-based reconstruction only. 

• Gap fill process now generates more realistic turbulence data. 

• Turbulence Analysis window now shows data for all heights at once. 

• New Representative Year module for creating 'typical year' of data. 

• New Forecast Error Analysis module. 

• New concurrency option on Diurnal Pattern tab. 

• New ability to open ZPH files from ZephIR. 

• New ability to offset direction values in TAB files. 
 
Version 3.0 (August 27, 2012) 

• Added new measure-correlate-predict (MCP) module. 

• Added Compare Data Sets window to graphically compare two or more data sets. 

• Added Extreme Wind Analysis window that implements the Method of Independent Storms. 

• Added Flag By Scatter Plot window. 

• Added user-defined calculated data columns. 

• Added new Wind Turbine Output window. 

• Added database export option. 
 
Version 2.0 (April 30, 2010) 

• New data flagging and filtering capability. 

• New Tower Distortion Analysis module. 

• Improved raw data file import logic. 

• Added database import. 
 
Version 1.0 (September 26, 2005) 


